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How to Get Started
This game is written as a MDI application.    The game main window is divided into many 
child windows.    Each of the child windows (Strategic, Tactical, and Ship Status) is moveable 
and resizable.    The Strategic window is used to give the player an overall view of the galaxy.
The buttons represent the sectors of a galaxy.    The Tactical window is the close-up view of a
sector.    The Ship Status window displays the current status of the player's ship.

The menu commands are different depending on the currently selected child window.    For 
instance, to use the Strategic Scan command, the player must first select the Strategic 
window as the active window.    Then, the Control menu option will change to reflect the 
commands available for the Strategic window.    Each window has different Control 
commands.

Most of the menu commands have an accelerator keyboard command.    For example, the 
Strategic Scan command can be invoked by the "C" key.    The accelerators are listed to the 
right of the menu command.



How to Use Main Window
Please click left mouse button on parts of window to receive help.



Toolbar
The toolbar is a collection of buttons that will invoke certain menu commands.    The toolbar 
is designed to make it easier to perform the commands.    Following is the meaning of the 
buttons:

 This button will perform the Strategic Scan Command.

 This button will perform the Strategic Game Status Command.

 This button will perform the Strategic Inventory Command.

 This button will perform the Ship Status Repair Command.

 This button will perform the Tactical Launch Decoy Drone Command.

 This button will perform the Tactical Hail Supply Ship Command.

 This button will perform the Tactical Dock Command.

 This button will perform the Tactical Order Drones Back Command.

 This button will perform the Tactical Orbit Command.

 This button will perform the Tactical Stop Command.



Message Line
The message line is used to communicate with the user.    Simple help messages are written 
into the message line when a toolbar button is pressed or a menu option is selected.    Also, 
miscellaneous messages are written in the message line during the playing of the game.    
The message is erased after a few seconds.



How to Use Strategic Window

 The player starts out a game in sector 0,0 (upper left corner of the Strategic window).    The 
button is pressed indicating the current sector being displayed by the tactical window.    The 
Sector Color Code for the sectors indicates the contents of the sector.    The player can use 
the Strategic Scan command to scan the sectors next to the current sector.    To move to 
another sector, the player presses the button of the sector to jump into.    A maximum of two
sectors can be jumped at a time.



How to Use Tactical Window

 The Tactical window uses the mouse to control the player's ship.    The left mouse button is 
used to activate the Tactical Popup menu.    The player places the cursor over the object to 
be acted upon.    Then the left mouse button is pressed.    The player then selects the 
command to be performed on the object.    For example, clicking the left mouse button on an
alien ship and then selecting "Fire Pulse Lasers" will fire the Pulse Lasers at the ship.    The 
player may also interact with some background objects such as a planet from the tactical 
display.    To move the ship, place the cursor at the destination and then press the left mouse
button. Now select "Set New Heading" command.



How to Use Ship Status Window

 The Ship Status window contains the current status of the systems for the player's ship.    
The status is constantly updated.    The player may change the order of the systems being 
repaired by using the Ship Status Repair command.    For example, if the player wishes to 
have the hyperdrive engines repaired, the player would select the "Repair" command.    The 
"Hyperdrive Engine" button is then selected to be repaired next.    The left mouse button can 
be pressed to invoke the repair command.

Pressing the left mouse button anywhere in the Ship Status window will show the repair 
dialog box.

The number of attack drones, decoy drones and missiles is displayed.

The status of the hyperdrive engines and pulse lasers is shown.



Background Objects
Background objects are seen on the Tactical Window.    They are objects contained in the 
current sector.    The player can interact with some of the objects.    Following is a list of the 
objects:

    This is a supply ship.    The player can dock with it.

    This is the alien planet Graceland.    The player can orbit the planet.

    This is our planet Earth.    The player can orbit the planet.



Copyright and Licensing

Copyright © BFM Software 1993
Copyright © Brett McDonald 1993

Following are the system requirements:
1) 286 or higher processor
2) Windows 3.1 or higher
3) Mouse or other pointing device
4) Color monitor - High SVGA resolution recommended.

This game is shareware.    This game is NOT free.    If you like the game and continue to use 
it, you MUST register the game.    Registration Fee: $14.95 U.S.

BFM Software
Brett McDonald
38602 Lancaster Drive
Farmington Hills, MI 48331

To receive a disk with the latest version add $4.00 to the registration fee.

Following are our BBS IDs:
Compuserve ID - 73770,1254
American On-line ID - BrettMc

We are a member of the Compuserve Shareware Registration system.    You may register 
BFM Software products with Compuserve.    They will add the fee to your bill and we will send
you the registration.    To access this system enter "GO SWREG".    Select Register Shareware. 
Then search for the keyword "BFM" to find all BFM Software products.

Please include your name EXACTLY as you want it registered and the generated key from the
registration dialog box.

You may distribute this software as long as the following files are included:
WESREAD.TXT
WES.EXE
WES.HLP

All of the above files must be combined into a single file ZIP or other compression format for 
distribution.

Beyond a fee for the reproduction and media cost, no fee may be charged for distribution of 
this software.

This software claims no warranty, implied or otherwise.    This software is provided "AS IS".    
The author claims no responsibility for any damages that might be caused by the use or 
abuse of this software.    This software remains the property of the author.    This software 
may not be modified in any way.



Game Storyline
We would like to inform you that Elvis is definitely still alive!    That's right, he didn't fake his 
own death nor was he drugged by a jealous husband whose wife is a walking, talking 
Priscilla-wanna- be-doll.    Elvis did not overdose on little green pills either.    Rather, he was 
taken from us by little green creatures, most commonly known as "aliens."    Elvis has been 
kidnapped by ALIENS!! Yes, it's sad, so very sad, but true.    O.K., calm down.    Don't get your
pelvis in an uproar!    It is important that you stay collected.    You are going to play a crucial 
role in the mission of bringing Elvis home.    But, we will explain that to you later.    "How can 
this be true?" "How did you find this out?" "Are you an investigative genius?" you might ask. 
Good questions, indeed.    Well, let me fill you in.    Our team of investigators, the SIVLE 
("Elvis" spelled backwards or Some Idiots Violated the Life of Elvis), found much evidence.    
First of all, as you may already know, Elvis' name on his gravestone is misspelled which 
turned out to be a secret alien code.    Secondly, the aliens have given us clues of the 
abduction through their crop-drawings.    We found that this particular colony of aliens is 
obsessed by Elvis just as our people were in the 1950's.    Their planet, Graceland, was found
to be 30-odd light years away.    So, it has taken this long for Elvismania to reach their planet.
Now, this is where you come in.    Elvis' immediate family already knows of this.    Lisa Marie 
has initiated the building of the X63 interstellar cruiser that will send you on the mission to 
bring her father home.    You must now try to find the alien planet Graceland.    "Why did we 
select you?"    Well, do you have anything better to do with your life?!



Game Levels
This game can be played at different levels.    The three levels are Beginner, Normal and 
Advanced.    Below are the descriptions of the levels:

Beginner
This level is designed for new players.    It is very easy and not very challenging.
* The ? Command bubbles are automatically displayed at the beginning of the game.
* The player gets fewer missiles.
* The player gets fewer attack drones.
* There are fewer alien ships in the galaxy.
* Alien ships fire slower.
* The player's score is penalized.
* One less Decoy Drone is supplied.

Normal
This level is designed for a moderately paced, somewhat challenging game.

Advanced
This level is designed for players wanting a challenge.    It is very fast paced.
* The player gets more missiles.
* The player gets more attack drones.
* Many alien ships are in the galaxy.
* Alien ships fire faster.
* The player's score is enhanced.
* One more Decoy Drone is supplied.



Natural Disasters
Natural Disasters are just a few of the situations commanders must deal with.    The 
situations are very random and are not predicable.    They are just a "fact of life" while being 
in space.

Some natural disasters will cause damage to any ship in the sector.    Ships in a planet's orbit
will be protected by the atmosphere.    These types of Natural Disasters can either work for 
or against a player.    If the player's ship is very damaged, it could finish the player off.    On 
the other hand, it will also damage all the other ships in the sector the player is trying to 
defeat.    Super Nova Bursts and Ion Storms are examples of these.

The other natural disaster is called a Wormhole.    It does not cause damage to a player's 
ship, instead, the Wormhole makes it more difficult to keep control of the ship.    It moves the
ship to another location in the galaxy.    This natural disaster can also work for or against a 
player, depending if the player wants to be moved away or near a sector with alien ships.



Relics
As the aliens traveled to Earth over the last few years, they have stolen some very valuable 
Elvis relics.    They are as follows:

The above objects are a Gold Album, Fendor Guitar, White Studded Jumpsuit, Peanut-
butter/Bananas, Pink Cadillac, 8-track tape, and a Black Velvet Painting, respectively.

These relics are very highly valued by the aliens.    The captains of their ships were given 
these objects as a reward for capturing Elvis.    You must destroy the alien ships to get the 
relics.    These are the only things the aliens are willing to trade Elvis for.



Scoring
Win Elvis-n-Space keeps track of the player's score throughout the game.    Every time an 
alien ship is destroyed, the player's score is incremented.    The current score can be 
displayed from the Strategic Control Status command.    The dialog box displayed will contain
the current and high score for the player.
Scoring values for destroying objects are as follows:

Object Score Description

16 Hound Dog Class Ship

22 Rock-n-Roll Class Ship

30 Heartbreaker Class Ship

4 Burning Love Class Fighter

1 Neutron Pellet

The score is multiplied by the game level.    The levels are beginner - one, normal - two, and 
advanced - three.    For example, if an object's score is 10 and the player's level is normal, 
the total score for destroying the object is 20.

The following will cause a player's score to be decreased:
* Launch Decoy Drone - decrease by 50.
* Dock with Supply ship - decrease by 25.

A bonus is given to the player for destroying all alien ships in the galaxy.    The bonus is 
based on the time taken to complete the game.



Sector Color Code
The Sector Color Code is the code for the notches in a scanned sector on the Strategic 
Display.    Below is an example of a sector display followed by an explanation.

The gray button on the left is an unscanned sector.    The bottom of the window has the color
code as follows:

HDg - Hound Dog Ship
Rock - Rock-n-Roll Ship
HBrk - Heartbreaker Ship
Plan - Planet

For example, the pressed button indicates that at least one Hound Dog and Rock-n-Roll ship 
is in the sector.



Ships
The Earth only has one interplanetary ship class.    Below is the information on that ship:

Class: X63
Type: Heavy Cruiser
Weapon: Pulse Lasers, Attack Drones and Missiles
Speed: Average
Armor: Strong
Hull: Thick

This ship is an all around performer.    It is very large and heavily armored.    It uses fighters 
as its main weapon.    This ship is fast and very well designed.    It will serve the player well.

Class: Attack Drone
Type: Drone
Weapon: Laser
Speed: Very Fast
Armor: Weak
Hull: Thin

This drone is fast.    It uses a small laser.    This attack drone is carried by X63s.

The aliens have a few different ship classes.    Below is the information on each class:

Class: Hound Dog
Type: Destroyer
Weapon: Sonic Blaster
Speed: Fast
Armor: Medium
Hull: Medium

This ship uses a sonic blaster to shake the opponent's ship apart.    This weapon has a long 
range and delivers quite a punch.

Class: Rock-n-Roll
Type: Destroyer
Weapon: Neutron Pellets and Tractor-Repulsor Beam
Speed: Slow
Armor: Medium
Hull: Medium

This ship launches neutron pellets that track the opponent's ship.    These pellets can do a lot
of damage.    This ship also uses a tractor-repulsor as a defense against missiles and drones.

Class: Heartbreaker
Type: Carrier
Weapon: Fighters and Tractor-Repulsor



Speed: Slow
Armor: Heavy
Hull: Thick

This ship launches fighters that track the opponent's ship.    These fighters do the dirty work 
for the ship.    This ship also uses a tractor-repulsor as a defense against missiles and drones.

Class: Burning Love
Type: Fighter
Weapon: Plasma Fire
Speed: Very Fast
Armor: Weak
Hull: Thin

This fighter uses a plasma fire thrower.    A group of these fighters can overwhelm an 
opponent.



Tips on Playing
This topic will give a few tips on how to play Win Elvis-n-Space.    The tips are as follows:

Strategic Display
* The player should use Scan Command to view sectors before entering.    This will eliminate 

surprises.
* The player must remember that if the scanners are destroyed, all the sector displays will 

be reset.

Tactical    Display
* To defeat Hound Dog class ships - the player should fire pulse lasers at the ship from long 

distance.    Missiles and attack drones don't do well against the Hound Dog's sonic 
blaster.

* To defeat Rock-n-Roll class ships - the player should fire a few missiles at the ship.    The 
missiles will destroy the ship.    The player should run from the Neutron Pellets.

* To defeat Heartbreaker class ships, launch a few attack drones.    When the attack drones 
are about half way to the ship, a couple of missles should be launched.    The attack 
drones will destroy the Heartbreaker's fighters on the way there.    The missiles will then 
destroy the ship.

* The player can hail a Supply Ship when supplies run low.
* Releasing a Decoy Drone is a good way to get out of a critical situation.    The alien ships 

will attack it and not the player's ship.

Ship Status Display
* The player can use the Repair command to indicate which damaged system to repair next. 

Damage control repairs systems in a certain order.    The order is listed on the repair 
screen.    Damaged systems are repaired in a top-down manner.

* The player invokes the Repair command by clicking the left mouse button anywhere in the 
Ship Status window.

General Tips
* Try to keep moving.    The longer the player stas in a sector the greater the chance is that 

something bad will happen.
* Find all the relics and then go trade for Elvis on Graceland.    After that, go back to Earth to 

win the game.



Menu Commands
File Menu
cc Control Menu
Option Menu
Window Menu
? Command
Help Menu

Tactical Popup Menu



File Menu
The File Menu includes commands that enable the player to control the game.

For more information, the user should select the File Menu Command Name:
New
Register
Uninstall
Exit



New
Selecting the New Command from the File Menu will cause a dialog box to be displayed.    
The user can then restart a game or cancel the new command.    The user can select among 
three game levels which are beginner, normal, and advanced.    The sound may also be set 
on or off on the dialog box.



Register
Selecting the Register Command from the File Menu will cause a dialog box to be displayed. 
The register command is used to register the game.

The user should enter his/her name in the name fields.    This is used in messages to the 
user.    The user must enter his/her first and last name.

The register dialog box has directions on the steps needed to register the game.    This 
software must be registered after the 15 day trial period.



Uninstall
Selecting the Uninstall Command from the File Menu will cause a message box to be 
displayed.    The user can select YES or NO to uninstall Win Elvis-n-Space.    

The following files are removed from the user's system in the uninstall processing:
* WESREAD.TXT - text file with miscellaneous Win Elvis-n-Space information
* WES.EXE - Win Elvis-n-Space program file
* WES.HLP - Win Elvis-n-Space help file
* WES.INI - Win Elvis-n-Space parameter file

Note: If share is installed in the user's system, Win Elvis-n-Space will encounter an error in 
the uninstall process.    Share will not allow a program to access a file that another program 
is accessing.    Windows is executing WES.EXE so the program cannot access it to delete it.    
The error message can be ignored and the WES.EXE file deleted by hand. 



Exit
Selecting the Exit Command from the File Menu will terminate Win Elvis-n-Space.



xxx Control Menu
The Control Menu includes commands that enable a user to issue commands for the 
currently active window.    This game is an MDI windows application.    Therefore, the control's
command will have different options based on the currently active window.    To make a 
particular window active, the user must either click in the windows or use the window 
command to select the window.

For more information, the user should select the Control Menu for the particular window:

Strategic Display Window
Scan
Game Status
Game Inventory

Tactical Display Window
Launch Decoy Drone
Order Drones Back
Hail Supply Ship
Dock
Orbit
Stop

Ship Status Display Window
Repair



Strategic Scan Command
The Scan Command will scan the sectors around the current sector.    The sectors will lose 
the black null indication on the button face for the scanned sectors.    The sectors will 
indicate the contents by the color of the notches in the button.    The Sector Color Code 
allows a user to determine the contents of a sector without entering the sector.



Strategic Game Status Command
The Game Status command will display a dialog box that contains information on the status 
of the current game.    It will display the following information:

Level of game - level of the current game
High Score - highest score yet obtained for the game
Current Score - score of the current game
Game time - length of current game
Current location - current sector of player's ship
 Location of Elvis - if Elvis is currently on the ship
Alien Ships - number of alien ships still remaining



Strategic Inventory
This is the inventory of all the objects the player has found in the wreckage of destroyed 
ships.



Tactical Release Decoy Drone Command
Decoy Drones are carried on all X63 class ships.    This drone may be released at any time.    
The drone will travel to the opposite end of the sector, hopefully leading the alien away.    
The drone will have enough fuel to operate for about one minute.    Only a few Decoy Drones 
can be carried on a ship.    The number of Decoy Drones remaining is displayed on the Ship 
Status Display.



Tactical Order Drones back Command
The Order Attack Drones Back Command will cause all the player's attack drones to return to
the ship.



Tactical Hail Supply Ship Command
The Hail supply ship command will request a supply ship to enter this sector.    The message 
takes a while to reach the supply ship.



Tactical Dock Command
The Dock Command will dock the ship at a supply ship.    The ship must be close to the 
supply ship to dock.    Docking will restock the ship with Attack Drones and Missiles.    The 
rate of repair will double in speed.    Also, the player can only dock with a supply ship once in
a sector.



Tactical Orbit Command
The Orbit command will cause the ship to orbit a planet.    The ship must be close to the 
planet to orbit.    A planet can only be orbited when no alien ships are in the sector.    If there 
are ships in the sector, they must first be destroyed.



Tactical Stop Command
The Stop command will cause the ship to stop all movement.



Ship Status Repair Command
The Repair command is used to indicate which system the user would like repaired next.    
Damage control will repair the systems in a top-down order.    A dialog box is displayed with 
all the systems.    The undamaged systems are grayed.    The next system to be repaired is 
selected.    The user may select a system to be repaired next by setting the button on the 
dialog box.



Options Menu
The Option Menu includes commands that enable the user to control options of the game.

For more information, the user should select the Option Menu Command name:
Sound
Storyline
Bubbles
Pause



Sound Command
The Sound command will turn game sounds on or off.    The state of the sound switch is 
saved from game to game.



Storyline Command
The Storyline command will turn the playing of the game storyline on or off.    The state of 
the storyline switch is saved from game to game.



Bubbles Command
The Bubbles command will turn the automatic display of help bubbles off when playing a 
beginner level game.



Pause Command
The Pause command will pause the current game.    A help button is placed on the dialog box
for the user to access help.



Window Menu
The Window Menu includes commands that enable the user to control the windows of the 
MDI application.

For more information, the user should select the Option Menu Command name:
Cascade -- cause windows to be stacked on top of each other.
Tile -- cause windows to be fitted next to each other on the main window.
Arrange icons -- arrange iconic windows on the main window.
Windows -- select a window to become active.



? Command
The ? Command will cause informational bubbles to be displayed on all open windows 
explaining the window.    The bubbles are a short and quick form of help.    The bubbles will 
be erased in a short while.    The ? Command can be selected again to clear the bubbles.

A game started in beginner mode will automatically have the ? Command displayed at the 
beginning of the game. If the Bubble option is not selected, the bubbles will not be displayed
in the normal and advanced modes.



Help Menu
The Help Menu includes options that enable the user to get help for the game.

For more information, the user should select the Help Menu Command name:
Help Index
Using Help
About



Help Index Command
The Help Index command is used to invoke the Windows Help engine.    It will start up with 
the help index for Win Elvis-n-Space.



Using Help Command
The Using Help command will invoke the Windows Help engine.    It will start up with the help
for the Help engine.



About Command
The About command will display a short dialog box that displays copyright and registration 
information.    The More key may be pressed to display a picture of the development team for
this software.    The Register key may be pressed to register this software.



Tactical Popup Menu
The Tactical popup menu is used to perform commands on an object in the Tactical window.

For more information, the user should select the Tactical Popup Menu Command name:
Set New Heading
Fire Pulse Lasers
Launch Missile
Launch Attack Drones
Scan
cancel this menu



Set New Heading
The Fire Lasers command is selected from the Tactical Popup Menu.    The Set New Heading 
command is used to move the player's ship to a new location.



Fire Pulse Lasers
The Fire Pulse Lasers command is selected from the Tactical Popup Menu.    The player's ship 
will fire its lasers at the alien ship that is nearest to the cursor.    The lasers require a short 
time to recharge.    The lasers may be fired as many times as desired.    An alien ship must be
within a short distance from the cursor before the lasers can be fired.



Launch Missiles
The Launch Missiles command is selected from the Tactical Popup Menu.    The player's ship 
will launch a missile at the alien ship that is nearest to the cursor.    The player only has a 
limited number of missiles.    They can be restocked by docking with a supply ship.



Launch Attack Drones
The Launch Attack Drone command is selected from the Tactical Popup Menu.    The player's 
ship will launch an attack drone at the alien ship that is nearest to the cursor.    The player 
has a limited number of attack drones.    They can be restocked by docking with a supply 
ship.



Scan
The Scan command is selected from the Tactical Popup Menu.    It is used to scan objects in 
the sector.    An object must be within a short distance from the cursor to be scanned.    A 
dialog box will be displayed with information about the object and its status.



cancel this menu
The cancel command can be used to cancel the popup menu.    The user can also press the 
Esc key to cancel the popup menu.



Keyboard
Keyboard commands are shortcuts to the menu options.    All menu options that have 
keyboard shortcuts have the shortcut key listed next to the menu command.    The following 
is an example: 

Scan 'C' - Scan is the menu command.    Pressing the 'C' key will invoke the Scan 
command.

Following are the keyboard shortcut commands:
Menu Command Short-cut Key
Strategic Scan 'C'
Strategic Game Status 'G'
Strategic Inventory 'I'
Tactical Launch Decoy Drone 'Y'
Tactical Order Drones Back 'B'
Tactical Hail 'H'
Tactical Dock 'D'
Tactical Orbit 'O'
Tactical Stop 'P'
Tactical Popup Set New Heading 'N'
Tactical Popup Fire Pulse Lasers 'L'
Tactical Popup Launch Missiles 'M'
Tactical Popup Launch Attack Drone'A'
Tactical Popup Scan 'S'
Ship Status Repair 'R'



Mouse
The mouse has a few special functions in Win Elvis-n-Space.    The functions are different for 
each window.    Following are the mouse functions for each window:
Strategic Window
* The left mouse button is used to select the sector the player wishes to jump into.    The 

cursor will change into an outline of the ship when a jump is allowed.    The sector button 
is single-clicked to activate the hyperdrive engines.    Only one sectors can be jumped at 
a time.

Tactical Window
* The left mouse button is used to activate the Tactical Popup Menu.    The player moves the 

cursor on top of the object to be processed.    Also, press the left mouse button on the 
location to move the ship, then select the "Set New Heading" command.

Ship Status Window
* The left mouse button is used to display the Repair dialog box.



Win Elvis-n-Space Definitions
Following are the defined terms of the game:

Armor
Attack Drone
Carrier
Cruiser
Decoy Drone
Destroyer
Fighter
Galaxy
Hail
Hyperdrive
Ion Storm
Jump
Lasers
MDI
Missile
Neutron Pellet
Pulse Lasers
Scanners
Sector
Sensors
Strategic
Super Nova Burst
Supply Ship
Tactical
Thrusters
Tractor Repulsor Beam
Win Elvis-n-Space
Wormhole



Armor
Armor is a magnetic metallic layer around a ship or fighter.    It will protect the object from 
weapon damage for a short amount of time.    It can be regenerated.    After the armor is 
penetrated, the hull will start to become damaged.



Attack Drone

Attack drones are small electronic drones that are completely computer controlled.    They 
are carried by other ships.    Attack drones are usually sent on a mission in groups.    They 
carry greater fire power in numbers.    After a mission is complete, they will return to the 
ship.



Carrier
Carriers are large ships that carry fighters.    They are bases for the fighters.    Carriers, 
themselves, are almost defenseless.    The fighters give the carrier a big punch.



Cruiser
Cruisers are large ships.    They are the best all around ships.    They carry attack drones for a
long distance attack and heavy guns for short distance.    It also carries decoy drones that 
allow it to distract enemy ships.



Decoy Drone

A Decoy Drone is very heavily loaded with electronic counter-measure equipment.    This 
equipment is used to create a simulation of the ship that launches the drone.    To any ship in
the sector, the drone will appear to be the ship.    The drone also has a large amount of 
armor to protect it while operating.    The drone uses a hyperdrive engine operating on 
overload to achieve the level of energy needed.    The ion engine will burn out in a short 
amount of time.    The drone cannot be recovered.



Destroyer
Destroyers are small ships.    They are very expendable.    They have very little armor and fire
power.



Fighter
Fighters are small ships with a single crew member.    They are carried by other ships.    
Fighters are usually sent on a mission in groups.    They carry greater fire power in numbers.   
After they complete a mission, they will return to the ship.



Galaxy
A galaxy is the known section of the universe where our Earth and the planet Graceland are 
located.    This is also the range of the scanners.    The galaxy is made up of sectors.    The 
Strategic Display is the display of the galaxy.



Hail
Hailing a ship is another name for contacting other ships on the interstellar radio.    A 
message takes a while to travel the wide expanses of the galaxy.



Hyperdrive Engine
A Hyperdrive Engine is used to travel around a galaxy.    They function by super heating 
hydrogen gas until it becomes plasma.    Then a magnetic field is applied and a large amount
of ions are emitted.    These ions are used to jump the ship to the speed of light and appear 
in the next sector.    After a hyperdrive engine is used, it must cool down.    This takes less 
than a minute.



Ion Storm
An ion storm is caused by certain gases reacting.    These gases cause an electromagnetic 
reaction that will ionize an entire sector.    The ionization of the sector will react with the 
electronics of a ship.    The effect is quite powerful.    It will damage anything in the sector not
protected by an atmosphere.



Jump
A Jump refers to the process of going the speed of light.    A Hyperdrive Engine is required to 
supply the large amount of energy needed for a jump to light speed.



Lasers
Lasers emit a beam of concentrated coherent light of the same wavelength.    The laser 
beam can travel over great distances.



MDI
MDI stands for Multiple Document Interface.    MDI windows applications have multiple 
windows contained within one main window.    Program Manager or SysEdit are examples of 
MDI applications.



Missile

 A missile is a self-propelled nuclear warhead.    It is fast moving and very powerful.    Missiles 
have a small amount of armor to protect them from some weapon fire.    Multiple missiles 
should be fired at a target to ensure a kill.



Neutron Pellet

A Neutron Pellet is a pellet that is shot by a railgun at the target.    The railgun accelerates 
the neutron pellet to near the speed of light.    The neutron pellet is very dense matter.    It 
has a guidance system to track the target.    The pellet is very fast moving.    When the pellet 
reaches its target, its mass will cause damage.    No explosives are needed.



Plasma Fire
A plasma fire cannon is a weapon that uses plasma as sort of a flame-thrower.    The plasma 
is heated to a high temperature and then ignited.    The stream of burning plasma is then 
directed toward the target.



Pulse Lasers
Pulse Lasers emit a beam of pulsed, concentrated, coherent light of the same wavelength.    
The laser beam can travel over great distances.    The pulsed beam is very powerful.    Pulse 
Lasers use a capacitor to store energy.    The capacitor requires time to recharge between 
firing.



Scanners
Scanners are a ship's long range sensing equipment.    They are used to scan the 
surrounding sectors of a ship's current location.    Once a sector is scanned, its contents are 
recorded in the scanner's database.    This database of information is displayed on the 
Strategic Display.    When scanners are destroyed, the record of scanned sectors is lost.    The
sectors must be rescanned when the scanner is repaired.



Sector
A sector is the smallest subdivision of the universe.    Sectors are the tactical portion of 
space.    The tactical display is the view of a sector.    A Galaxy is made up of sectors.



Sensors
Sensors are a ship's short range sensing equipment.    They are used to scan objects within a
sector.    They can be used to scan ships.    The sensors also aid the fire control computers to 
lock-on to a target.    When the sensors are damaged, the effectiveness of weapons is 
reduced by 50%.



Sonic Blaster
A sonic blaster is a weapon that uses photon waves generated from high density sound 
waves.    These sound waves pass through a dense magnetic field that excite photons.    The 
photons are released with a great deal of energy.



Strategic
Strategic is a term used to define an overall long range look at a situation or problem.    In 
Win Elvis-n-Space the Strategic Display window shows the sectors of the galaxy.    From this 
display, the player can plan the conquest of the sectors.



Super Nova Burst
A super nova is an unstable neutron star.    The neutron star contracts upon itself.    The force 
of the compression will cause the star to explode.    The energy burst is quite powerful.    It 
will damage anything in the sector not protected by an atmosphere.



Supply Ship

A supply ship is a fast ship that carries supplies for ships.    The ship is not maneuverable 
inside a sector.    The ship will be stocked with attack drones and missiles.    When a ship 
docks with a supply ship, the supplies are transferred.    A supply ship can only be docked    
once in a sector.    A supply ship can only be hailed a limited number of times in a game.    
Also, the supply ship will not come if alien ships are in the sector.



Tactical
Tactical is a term used to define a close-up or short-range look at a situation or problem.    In 
Win Elvis-n-Space, the Tactical Display window shows the current sector where the player's 
ship is located.    This is where the player does most of the "work".    The alien ships are 
engaged here.    The player docks with derelicts to restock and to take a rest.



Thrusters
Thrusters are a chemical engine.    They use a chemical reaction from hydrogen and oxygen.  
The stream produced moves the ship.    Thrusters are used to move around sectors.



Tractor Repulsor Beam
A Tractor Repulsor Beam is a very advanced form of a Tractor Beam.    This weapon can 
switch from pull to push at a microsecond rate.    This will virtually shake the target apart.    It
has a very short range.



Win Elvis-n-Space
Win Elvis-n-Space is a copyrighted game created by BFM Software.

Copyright © BFM Software 1993
Copyright © Brett McDonald 1993



Wormhole
A wormhole is a time-space inter-dimensional connection.    It will instantly transport an 
object great distances.    Wormholes are undetectable until they are encountered, and then it
is too late!    They will move a ship many sectors.    Their appearance is random.    Wormholes 
do not cause damage to the ship.




